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Node of proposition- 

broad concept at the top 

Node of concept – more 

specific concept in sub-layers 

 Link 

Label for a link 

Representative Definition and Basic Components 

Concept maps are graphical tools for organizing and representing knowledge. A concept map should be read 

from the top to the bottom, proceeding from the higher order--more general--concepts at the top to the lower 

order--more specific-- concepts at the bottom. Concept maps also have crosslinks that show relationships 

between ideas in different segments of the map. 

References:  

Novak, J.D., & Canas, A.J. (2006). The Theory Underlying Concept Maps and How to Construct Them.  

Novak, J.D. (1998). Learning, Creating, and Using Knowledge: Concept Maps as Facilitative Tools in 

Schools and Corporations.  

 

Basic Elements of a Concept Map 
(Marked with red callouts) 
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About Concept Mapping Software 

Basic Functionalities of Concept Mapping Software: 

 Creating nodes of concepts or propositions  

 Creating links 

 Adding labels to links 

 Formatting nodes, links and labels 

 Toggling between map and outline modes 

 Adding notes or annotations 

 Adding media/resources files, including graphics, sound/video files, presentation files, word-

processing files, and hyperlinks 

 Exporting a concept map as an image, a webpage or website, and a formatted or unformatted text 

document 

 Checking with thesaurus 

 

Advanced Features: 

 Collaborating in concept mapping creation/editing 

 Comparing maps  

 Capturing the process of map creation (if time permits) 

 Nesting maps (if time permits) 

 Retrieving and organizing content from online databases (possible topics) 

 

Two Concept Mapping Tools in This Tutorial:  

 Inspiration 8 – educational and commercial software by Inspiration Software Inc. 

 CmapTools™ –software free for educational institutions, developed by the Institute of Human & 

Machine Cognition (IHMC) 
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Visualized Hands-on Guide for Inspiration 8 

 

 

 

 

 

Arrange nodes to 

different types of 

concept map 

Create links 

between nodes of 

concepts with Link 

button  

Toggle between 

diagram & outline 

Symbol Palette: create 

nodes of concept with 

symbols or images  

File menu: 

Create, save, & 

export concept 

maps 

Transfer concept map 

to a formatted Word 

document 

Add annotations 

to concepts 

Text, Symbol, Link, Effect 

menus: Format text, symbol, 

link & entire map 

Tools menu: Insert 

sound/video; Record 

sound 

Add hyperlink to 

concept symbols 

Look up 

words/synonyms  

Canvas: create maps on it 

Note: background can be 

customized with colors & images 

Style Palette: Format font, links, objects, 

and symbols of concepts  
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Using Inspiration to Create Concept Maps: 

Using the Symbol Palette to add a symbol 

Drag the symbol from the Symbol Palette onto the diagram. 

–or– 

Click where you want the symbol to appear, then click the symbol on the Symbol Palette. 

 

Connecting ideas using the Link tool & link creation points 

You can use the Link tool to quickly create links between symbols: 

1. On the main toolbar, click the Link button.  

2. Select the symbol where you want the link to begin. The cursor changes to the shape of an arrow with 

two crossed circle behind it. 

3. Select the symbol where you want the link to end. 

4. The link appears and the arrowhead points to the second symbol you selected. 

5. To continue creating links between symbols, repeat steps 2-3.  To turn off the Link tool, click the 

Link button, or click the background of the diagram. 
 

A symbol has four diamond-shaped link creation points. You can create a link quickly by clicking a link 

creation point on the symbol where you want the link to begin, then clicking a connection point on the 

symbol where you want the link to end. 

To connect ideas using a link creation point: 

 

In this example, the link was from a more general concept (or 

proposition) of “human heart” to a more specific concept of “right 

atrium”. The four diamond shapes are the link creation points. 

 

Note: A symbol can have 8 or 32 connection points, which can be very useful at 

formatting a map with many concepts. To show 32 connection points, click the 

symbol first, then choose 32 Link Connection Points on the Link menu (See the 

visualized hands-on guide on page 4).  

Or, hold down the Command key (Macintosh) or Ctrl key (Windows) as you create the link. 

 

 

 

 

 Link creation point 
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Using the Create tool to add a linked symbol in any direction 

You can use the Create tool to add a linked symbol in any direction. The symbol appears in the direction 

you choose. 

1. Select the symbol to which you want to connect the new symbol. 

2. On the main toolbar, click the point on the Create button that aims in the 

direction where you want to add the new symbol. 

Note: Each point on the button works like a separate tool. Position the cursor over the one you want 

to use, then click. The new symbol appears on your diagram connected to the selected symbol in the 

direction you chose. The new symbol is selected and ready for you to enter an idea. 

3. Enter your idea in the symbol. 

Note: You can now add another symbol to the one you just created or select another symbol in the 

diagram and repeat the process described above. 

 

Exporting Inspiration concept maps 

To save an Inspiration outline as a plain text file: 

1. Open the outline. 

2. On the File menu, choose Export. 

3. Click the Word Processor tab. 

4. On the File Format menu, select Plain Text. 

5. Under Export Outline with, select the elements to include in the exported document. 

6. Click Save. 

7. Select the folder in which to save the document. 

8. Enter a name for the document, then click Save. 

 

To save an Inspiration document as a word processing document: 

1. Repeat the 1-3 steps above. 

2. On the File Format menu, select Microsoft Word or Appleworks. 

3. To include a graphic of diagram in the exported document, select Include the diagram. 

4. Repeat the 5-8 steps as in “saving an Inspiration outline as a plain text file”. 

Note: When an Inspiration document is exported to a word processing file, it keeps the outline structure 

as layers of indented items, with annotated notes as blocks of text under the associated items.  It also 

keeps the structure of hyperlinked files, such as a media file in the same local computer or a web site. 

 

To save a diagram as a graphic: 

1. Open the Inspiration diagram. 

2. On the File menu, choose Export. 

3. Click the Graphic File tab. 

4. On the File Format menu, select the graphic file format, such as BMP, GIF, and JPEG.  

5. To make the background of the diagram transparent, select the Transparent background check box 

(This option is available only for GIF format). 

6. Click Save. 
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7. Select the folder in which to save the graphic. 

8. Enter a name for the document, then click Save. 

 

 

Saving Inspiration documents as web pages: 

Inspiration diagrams and outlines can be saved (exported) as web pages, which can be viewed using a 

web browser, such as Internet Explorer or Mozilla Firefox. There are several options for saving diagrams 

and outlines as web pages. You can save an outline as one page or multiple pages. You can save a 

diagram as a graphic that appears on a single web page.   

 

The Site Skeleton export allows you to transform your diagram or outline into the foundation of a web 

site, including a clickable site map. Each symbol or topic becomes a separate page in your web site. The 

text of notes appears on the page corresponding to the symbol or topic to which it was associated. Links 

in your diagram become hyperlinks on your web pages. Arrows show hyperlink direction. Two headed 

arrows signify that there are hyperlinks back and forth between two pages. Single headed arrows make a 

hyperlink in one direction only. 

To export Inspiration documents as web pages,  

1. Open the Inspiration diagram. 

2. On the File menu, choose Export.  

3. Click the Web Pages tab. 

4. Select Site Skeleton radio button. 

5. Click Save. 

6. Select the folder in which to save the graphic. 

7. Enter a name for the document, then click Save. 

Note: By clicking Save, you will create a .htm file with a folder associated to it. If you want to change 

storage location of this site skeleton page/folder, you need to make sure you move both the .htm page and 

the folder to the new location.  
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Visualized Hands-on Guide for CmapTools™: 

There are two versions of CmapTools: a server version and a client version. The server version, in our case, 

Center for Instructional Technology, sets up the organizational center for CmapTools for all clients at JMU. 

This server enables all JMU users to store Cmap creations, organize related resources, and collaborate 

without depending on the free and public places supported by the Cmap central server. For viewing, creating 

or modifying a Cmap, CmapTools usually opens two windows: the main Views window (to the left in the 

screenshot below) and the map window (to the right with a file name, “onlineSurvey-attributes” in this 

example). 

 

 

 

 

 

 

Add a place to My Places  

Note: need to know the static IP address if 

it’s not a publicly viewable place 

View stored maps & resources 

on the institutional server 

File menu in Views window: Create new map, folder, & discussion 

thread (DT); import plain text files, Cmap outline, and even Inspiration 

outline 

Indicate possibility of creating 

new linked nodes by clicking & 

dragging mouse cursor 

Styles Palette: Format 

font, node, line, & Cmap 

Enable/disable 

synchronous 

collaboration

Display list view of 

concepts, outline, 

linking phrase, and 

proposition  

Get a list of 
suggestions for 
concepts to add to 
a Cmap  
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Using CmapTools™ to Create Concept Maps Collaboratively: 

Connecting CIT Cmap Server 

Setting up connection with the Center for Instructional Technology (CIT) Cmap server with your Cmap 

client software enables you to create concept maps collaboratively and store related resources in a JMU 

provided virtual space. To access this server: 

1. Open Cmap client software installed on your 

computer; 

2. Click Shared Cmaps in Places tab to the left of the 

Views window; 

3. Click Add Place buttons. 

4. In Add Places window, check Add a place that is 

not in the list; Enter 134.126.99.111 in Internet 

Host Name box; Enter 4447 in Port Number box; Enter 8080 in Web Server Port Number box, as 

displayed in the screenshot below.  

5. Click OK. CIT Cmap server is added to My places in your Cmap client. 

 

 

Note: if you want to connect to CIT Cmap server off campus, you will need the JMU VPN client for off-

campus connection. For details, please refer to JMU computing remote access page at: 

http://www.jmu.edu/computing/desktop/remoteaccess/ 
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Adding a new folder with userID and password 

After setting up connection between your Cmap client and CIT Cmap server, you will want to set up your 

folder to store your concept map creation, organize resources and collaborate with your students and 

colleagues. To add a new folder on CIT Cmap server: 

1. Select JMUCmapUsers folder under the main directory of 

Center for Instructional Technology 

2. In the File menu, select New Folder… 

3. In New Folder window,  

a. Provide a name to identify the folder in Folder Name 

box; 

b. Enter some keywords if you want to make this folder 

searchable in the future; 

c. Enter your name; 

Note: The user who first time set up a new Cmap folder is 

its administrator by default and can control access to it. 

d. Enter a password and confirm the password; 

Note: it doesn’t have to be your JMU e-ID and password. 

e. Click OK to exit the New Folder window. 

 

Giving other people access to the 

folder 

1. Select the folder that you want 

to give other people access to 

on the CIT Cmap server. For 

example, mediafiles folder in 

the screenshot to the right.  

2. In Edit menu, or right-click 

the folder, select 

Permissions…  

3. In Permissions List for 

mediafiles window, click 

Add Users… 

4. In Add User window, assign 

a User ID, grant a password 

for the assigned user, and set different levels of permissions for this specific user. 
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Importing a plain text outline 

1. In Views window, in either My Places or Cmaps in My Computer, select the folder in which you 

want to store the imported outline and its related map; 

2. In File menu, select Import…> Outline from Inspiration… 

3. Locate the .txt file on your computer in Select Text File Exported from Inspiration window; 

4. Click Open. You will have a new map with the nodes of concepts listed in the imported outline. 

 

Creating new nodes of concepts with labeled links 

1. Open a new Cmap or an existing Cmap; 

2. Double-click anywhere on the Cmap using the 

left mouse button. A shape will appear with 

question marks inside of it, as displayed in the 

screenshot to the right; 

Note: You may instead right-click anywhere on the 

Cmap and select New Concept from the menu that 

appears;  

3. Type a phrase to replace the question marks. Left-click on a white portion of the Cmap outside of the 

shape to finalize the typing. The shape has become a new concept. 

4. Click and drag from the angled arrows at the top of the concept . As you continue to hold the 

left mouse button down, notice that an arrow from the selected 

concept will follow around the mouse pointer. Once the two concepts 

are linked, a label space with question marks shows on the link, as 

displayed in the screenshot to the right. 

5. Replace the question marks in the label box with the labeling phrase. 

 

Increase the 

dimension of a node 

with this double-

arrow sign 
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Adding different types of files to a node of concept 

1. Open a Cmap and select the node 

for additional resources; 

2. In Edit menu, select Add & Edit 

Links to Resources or right-click 

the node and do the same selection 

in the drop-down menu. 

3. In Editing Resource Links 

window, locate the resource from 

CIT server, All public places in 

Cmap central server, Desktop, or 

My Cmaps folder in My 

Documents folder on your 

computer. 

4. Click Add to List and then click Update. 

 

Adding a discussion thread (DT) 

1. Open a Cmap saved in your folder on CIT 

Cmap server; 

2. Select a concept on the Cmap then choose 

New Discussion Thread... from the 

Collaboration menu if a DT is about the 

specific concept;   

-Or- 

If a DT is added to a folder instead of to a 

specific concept, select the folder and then 

New Discussion Thread... from the File 

menu, or choose Discussion Thread... 

from the New submenu when a folder is 

right-clicked.  

3. The "New Discussion Thread" window 

opens where you can set the DT initial 

properties, as displayed in the screenshot to 

the right. To create the new discussion 

thread, it must be given a name in the box 

next to the heading Name:, assigned the 

User ID and Password of the DT administrator, as well as the DT administrator's Email address. 

You may choose to ask for user registration, set when the DT and/or individual messages expire, 
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keep thread messages anonymous, and control when email notifications are sent. To create the new 

discussion thread, click Create.  

Note: the DT icon will appear on the concept and in the folder. A red DT icon will appear after 

the cmap has initially been saved and reopened, and only if there are messages in the thread that have 

not yet been read. Once all messages in the discussion thread have been read, the DT icon will return 

to its normal yellow color.  

Comparing two Cmaps: 

1. In an opened Cmap, select Tools then Compare to Cmap....  

2. The "Compare to another Cmap" 

console opens to the side of the 

cmap you are working on, as 

displayed in the screenshot to the 

right. You may choose to compare 

the two cmaps using any or all of 

these options: Propositions, 

Connections, Linking Phrases, 

and/or Concepts. Propositions, 

Linking Phrases, and Concepts may 

be compared using Full Text, and/or 

Partial Text to increase the 

probability of finding match. If you 

are connected to the Internet, you 

can make use of any or all of the 

following text matching options: Keyword, Synonym, and/or Hypernym. The Word Match slider 

can be adjusted to the percentage of words inside single concepts that must match in order to report 

the two concepts as "matching". To compare two cmaps, click Select Cmap..., browse for the cmap 

you want to perform the comparison with, then click Compare Cmaps.  

3. The other cmap will open beside the cmap you are working on. Once the comparison has been made, 

any matches will appear highlighted in green on both cmaps. You can view a detailed comparison of 

the two cmaps under the Results heading. These results may also be saved to a text file by clicking 

Export to Text File..., which opens the "Export Compare Results to Text File" window. To perform 

another comparison, or to remove the green highlighting from the two cmaps, click Reset.  

 

Exporting Cmaps as files of different formats: 

A Cmap can be exported as a PDF, web page, plain text, and XML file. It can also be exported as image files 

in a variety of formats, as displayed in the screenshot to the right.  
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To export a Cmap:  

1. In an opened Cmap, select File menu in the 

map window, then select Export Cmap As; 

2. Select the file format of your choice from the 

sub-list of Export Cmap As, as displayed in 

the screenshot below. 

3. In Export Cmap As window, find the 

location you want to save the file and type a 

name in File name box, and then click Save. 

 

Note: If you chose to export the Cmap as a web page, you will create a .htm file with a folder associated 

to it by clicking Save, just as with Inspiration. If you want to change storage location of this web 

page/folder, you need to make sure you move both the .htm page and the folder to the new location.  
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Using Concept Map in Our Class 

Examples 

 http://www.wcer.wisc.edu/archive/cl1/flag/cat/conmap/conmap1.htm  

Dr. Zeilik at the University of New Mexico used concept map to design fill-in questions to test 

students’ conceptual knowledge 

"You create a concept map and then remove concepts from the nodes (about one-third of them). 

These deleted concepts are placed in a numbered list on the map and students choose among them." 

… "Instructors of large classes may use multiple-choice type scanning sheets." … "The key is to 

select nodes that are at different levels of the hierarchy and have nearby or antecedent links." 

 

 http://iteslj.org/Techniques/Lee_ConceptMaps/  

Ching in her Technical Writing class at the Nanyang Technological University (Singapore) used 

concept maps to get feedback of students’ learning in class. 

"Concept maps which had only one level (no branching) often revealed that students had very 

superficial understanding of what has been learnt."..."The teacher may need to call these students up 

to find out further whether they are having real difficulties in their learning or is it because they are 

not motivated to start on their report yet." 

Suggested Uses 

 Course Design: You may use concept map in your course design. It would help to clarify the essential 

concepts, the course flow, and the alignment of the course objective, course materials, and 

assessments.  

 Collaborative Problem-solving in Learning: In a small group activity, ask students to use concept 

maps to generate and discuss procedures and alternative solutions.  

 Ongoing assessment: Ask your students to keep constructing concept maps about what they are 

learning  as the class goes on. At different times of a semester, you may review their concept maps, 
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identify their misunderstandings or confusions, provide instructions in class to correct or clarify their 

understanding, and adjust their next learning experience.  

 Final Assessment: Ask students to construct concept maps about major concepts of the course 

individually (in small class) or collaboratively (in large class) at the end of a semester. Concept maps 

provide a way to assess their understanding of conceptual knowledge and interconnection of that 

knowledge. 

How to assess a concept map? 

A popular method is to assess the density and thoroughness of a concept map. The number of relevant 

concepts on a core concept demonstrates how that core concept is defined in students’ understanding. 

Meanwhile, the complexity of the network on a concept map shows the level of students’ understanding. 

Students who understand a core concept very well will develop a concept map with highly interconnected 

structure. 

 

V.S.

From Concept Mapping as a Form of Student Assessment and Instruction at 

http://www.vanth.org/mmedia/vanth0103/vanth0103cd/papers/WalkerConceptMap02.pdf  

 

The table on next page is the rubrics to assess concept maps used by Dr. Raubenheimer at the North Carolina 

State University (http://www4.ncsu.edu/~cdrauben/concept%20maps/Concept%20Map%20Rubric.doc ). 
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 Level 1 (5 pts) Level 2 (6 pts) Level 3 (7-8pts) Level 4 (9-10 pts) 

Concepts 

Quantity/Quality of 

Words and their 

organization - 

Completeness 

Many key words and 

concepts from the unit 

are missing.  

Organization is choppy 

and confusing 

Many key words and 

concepts from the unit 

are covered and are 

somewhat organized. 

Most key words and concepts 

from the units are covered in a 

meaningful way and are 

thoughtfully organized. 

All key words and concepts necessary to 

promote an overview of the unit are used and 

well organized to give added meaning. 

Connecting 

Arrows (x2) 

Number and quality 

of Connections 

Level of Detail, 

Quality of 

Connections 

Linking Words 

Some words accurately 

connected. 

Connections aren't clear, 

they convey little 

meaning and do not 

promote clarity. 

Few to no linking words 

used above arrows. 

Most words accurately 

connected. 

Connections are 

somewhat clear and 

convey some meaning. 

Few linking words 

used above arrows. 

All words accurately connected. 

Connections are clear and 

logical.  They connect concepts 

to promote clarity and convey 

meaning. 

Relationships between concepts 

clearly identified using some 

linking words on arrows. 

All words accurately connected. 

Connections indicate superior organization/ 

understanding and enhance meaning.  Arrows 

easily connect concepts in an informative 

manner. 

Relationships between concepts easily 

identified using many linking words on arrows 

which are appropriate and varied. 

Accuracy Many misconceptions 

are evident. 

Many links are incorrect 

indicating poor 

understanding. 

Some misconceptions 

are evident. 

A few links are 

incorrect. 

All links are correct. 

Few to no errors evident. 

All links are correct. 

No errors evident. 

Total:              /40  

 



Concept Mapping Handout         Page 19 of 19 

Center for Instructional Technology ♦ Carrier Rm 22 540.568.7061 ♦ ECL 5th Floor 540.568.4836 ♦ cit.jmu.edu 
a Division of Libraries and Educational Technologies 

Resources: 

Concept Mapping Tools:  

 Inspiration: http://www.inspiration.com/freetrial/index.cfm 

 Cmap (free): http://cmap.ihmc.us/download/Ceryph_redirection.php 

 VUE (open source): http://vue.uit.tufts.edu/about/index.cfm 

 Others: 

 Freemind (free): http://freemind.sourceforge.net/wiki/index.php/Main_Page 

 WiseMapping (free): http://www.wisemapping.com/c/home.htm 

 SmartDRAW: http://www.smartdraw.com  

 

Educational Uses of Concept Mapping: 

Articles: 

 The Theory Underlying Concept Maps and How to Construct Them (Available at 

http://cmap.ihmc.us/Publications/ResearchPapers/TheoryUnderlyingConceptMaps.pdf) 

 Concept Mapping: A Graphic System for Understanding the Relationship between Concepts. ERIC Digest  

(Available at http://www.ericdigests.org/1998-1/concept.htm) 

 A Primer on Concept Maps (Available at http://academic.wsc.edu/frc/innovations.htm) 

 Applications of Concept Mapping to Undergraduate General Education Science Courses (Available at 

http://cmc.ihmc.us/papers/cmc2004-033.pdf) 

 Using Concept Maps to Gauge Students' Understanding (Available at 

http://iteslj.org/Techniques/Lee_ConceptMaps/ ) 

 

Web-based Examples: 

 Instructional Content Presentation: http://hyperphysics.phy-astr.gsu.edu/hbase/hframe.html 

 Visual Learning: http://www.mirandanet.ac.uk/visual/seminar.htm 

 Assessment: http://www.wcer.wisc.edu/archive/cl1/flag/cat/conmap/conmap4.htm 

 Tips on Making Your Own Concept Maps. Retrieved September 1, 2009 from 

http://classes.aces.uiuc.edu/ACES100/Mind/c-m3.html 


